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Welcome to OpenBook 
OpenBook is a software program that transforms your 
personal computer and scanner into a full-featured reading 
machine. Use any of today’s popular scanners to scan your 
favorite magazine, book, or newspaper article, and let 
OpenBook read that page aloud to you. Or open an electronic 
file from any of today’s most popular applications and edit at 
will. With OpenBook nothing is left inaccessible and even 
better, you are in control of how a page is read and presented 
on your computer screen.   

System Requirements 
The recommended system requirements for OpenBook 
include a personal computer with a CD-ROM drive, Windows 
2000, Windows XP, or Windows Vista.  

 
Specification Minimum Requirement 
Processor speed 500 MHz Intel® Pentium® or 

faster 
Memory (RAM) 256 MB (512 MB 

recommended 
Available hard disk space 
for installation 

460 MB 

Video 256 color graphics 
Sound Windows compatible sound 

card and speakers 
Keyboard 104 key Keyboard 
Scanner A TWAIN or WIA-compatible 

flatbed scanner  
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Installing OpenBook 
1. Insert the OpenBook CD into your CD-ROM drive. 
2. The OpenBook Setup program starts. You will hear the 

installation speak the instructions as they appear on 
your screen. Follow these instructions to complete the 
OpenBook installation. 

Note:  Have your software serial number handy. The serial 
number is located on the outside of the box and on the 
outside of OpenBook’s CD jacket. When you type in your 
serial number be sure to include any dashes. 

If your OpenBook installation CD does not start automatically, 
go to the Start button, select Run, and type D:\setup. If your 
CD-ROM drive is not D, substitute the correct drive letter. 

The OpenBook setup program will then begin. 

Choose to run the Typical or Custom installation of 
OpenBook. The Typical installation assumes that you want to 
install the default files, that you approve of OpenBook’s 
default location on your hard drive, and that you want the 
standard launchable programs configured. Use the Custom 
installation if you want to specify how OpenBook configures 
launchable applications, install additional recognition 
languages, and/or specify where OpenBook is stored on your 
hard drive.  

Note:  When you install OpenBook your scanner is 
automatically detected.  

Uninstalling OpenBook  
To uninstall OpenBook, go to the Programs Menu and select 
OpenBook 8.0. In the Tools submenu select the Uninstall 
OpenBook option.  
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Registering OpenBook 
Initial Registration  

Once you have completed the installation of OpenBook, you 
are ready to register your software license with Freedom 
Scientific. 

We encourage you to register your software. Registering your 
software costs you nothing, takes just a few minutes, and is 
the best way for you to receive quality service. Failing to 
register your software prevents us from providing you with 
technical support. 

You can register your software in one of two ways. The 
quickest and easiest option is to register over the telephone 
by contacting Freedom Scientific at (800) 444-4443 or (727) 
803-8000. When you call, you will need to provide your name, 
OpenBook serial number, and an address. 

You can also register by e-mail. To register by e-mail: 
1. Start OpenBook if it is not already running. 
2. Go to the File Menu and select Open or press CTRL+O. 
3. Type in the Filename edit box, registration.obx and then 

press ENTER. 
4. The registration document will open. 
5. Press CTRL+E to toggle to the Edit Mode in OpenBook. 
6. Use your ARROW keys to move down the screen and fill 

in the information requested. 
7. When finished, save the information by pressing 

CTRL+S. 
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8. Send an e-mail message to 
register@freedomscientific.com. Be sure to enter your 
product serial number in the subject line of the 
message and attach the registration form you just 
completed.  

Changing Your Registration  
If you need to change your registration information, such as 
your address or phone number, contact Freedom Scientific at 
the phone number listed above and provide your updated 
information. You can also send an e-mail containing your 
updated information to register@freedomscientific.com. 

Getting Started 
Launching OpenBook 

OpenBook gives you a variety of ways to launch the program.  
• Press the hot key, ALT+CTRL+O, which is automatically 

assigned when you install OpenBook.  
• Double-click the OpenBook icon on your desktop.  
• Go to the Start menu and select Programs. Choose 

OpenBook 8.0 from the OpenBook 8.0 menu.  

Once launched, OpenBook opens with a blank untitled 
document from which you can begin working or if you prefer, 
you can change the startup document to be the document 
you were working on last. To do this, go to the Settings Menu 
and select General Settings (ALT+G, G). In the General 
Settings Dialog, press TAB until you arrive on the Open 
Untitled Document on Startup radio button. Press the DOWN 
ARROW key to select the Open Last Document on Startup 
radio button. If you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Exit this properties page by pressing ENTER. 
Next, to change the settings so that OpenBook is always in 
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this Mode, open the Settings Menu again (ALT+G). From the 
Menu, choose Save the Settings... . In the Save Settings 
dialog, press ENTER to make the changes part of the default 
settings. For more information on this feature, please see the 
book, Using Settings Files. 

Closing OpenBook  
You can close OpenBook like any other Windows application 
by pressing ALT+F4, point the mouse and left click on the X 
in the top right hand corner of the window, or select Exit from 
the File menu.   

Scanning and Reading 
OpenBook combines the best in scanning and reading 
features to convert printed media into electronic format. It 
then displays and reads the content aloud giving you access 
to material that would otherwise be inaccessible or difficult to 
read.  

When you install OpenBook, the Eloquence text-to-speech 
software from Nuance is also installed. You can scan, edit or 
read a document. Additionally, you can customize the 
scanning, reading, and display properties of OpenBook. 

Here are a few shortcut keys to get you started with 
OpenBook.  
• To have OpenBook read to you, press INSERT+DOWN 

ARROW.  
• To scan, press SPACEBAR or F4.  
• To toggle between Edit Mode and Read-only Mode, 

press CTRL+E.  
• To silence speech press the CTRL key. 
• To read faster, press ALT+CTRL+PAGE UP. 
• To read slower, press ALT+CTRL+PAGE DOWN. 
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Getting Help 
Online Help System 

OpenBook’s Online Help System consists of three 
components, the Contents page with its tree view of books 
and topics, the Index page with its alphabetical listing of 
topics, and the Text View, which displays all topic content. 
When you launch Help, OpenBook automatically begins 
reading the contents of the Text View. To stop reading, press 
the CTRL key. To move from the Text View to the Tree View 
of books and topics, press F6. To return and begin reading 
the contents in the Text View, press F6 again. 

To navigate the books in the tree, use the UP and DOWN 
ARROW keys. The RIGHT ARROW key expands books to 
display the topics, while the LEFT ARROW key closes books. 
When you find the topic you want to read, press ENTER on 
the standard keypad. OpenBook Help displays that topic and 
automatically begins reading the contents.  

Note:  To display the selected topic in the Text View, you must 
press ENTER. Simply moving back to the Text View 
without pressing ENTER does not display or read the 
newly selected topic. 

The Index page is particularly helpful if you are searching a 
particular topic because it lists help topics in alphabetical 
order. To move between the Contents and the Index pages of 
Help, press CTRL+TAB.  

Navigating the Index’s list of topics is similar to navigating the 
Tree View of the Contents page in that you can use the UP 
and DOWN ARROW keys to move you up and down the list 
of topics. Or if you know the topic you want to find, type its 
first letter. For instance, you want information on the Zoom 
feature of OpenBook. You would then type the letter Z. The 
Index automatically moves through the list to that topic or to a 
topic that begins with the letter Z. 
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You can also navigate OpenBook’s Help System by pressing 
the TAB key. When you press the TAB key, you cycle 
between the three controls in Help. Pressing the TAB key 
once activates the Tree View or Index list, use the ARROW 
keys to navigate or open and close topics. Pressing the TAB 
key twice, activates the Tab Control on the Contents or Index 
page, use the LEFT and RIGHT ARROW keys to switch 
between the Contents or Index page. Pressing the TAB key 
again activates the Text View where the topic contents are 
displayed. Here you can press INSERT+DOWN ARROW to 
read or the ARROW keys to navigate the contents.  

Context-Sensitive Help 
When you are in a dialog box, press SHIFT+F1 to read the 
context-sensitive help message for the current item.  

You can also access context-sensitive help by right clicking 
the mouse on a control and selecting “What’s This” or by 
clicking on the ? (question mark) symbol at the top right 
corner of the dialog box and then clicking on a control. 

OpenBook User’s Guide 
We provide you with the content of the OpenBook Online 
Help System in the OpenBook User’s Guide, which uses 
large text for easy reading. The manual contains the Quick 
Start Guide, a detailed description of OpenBook’s features, 
and pull out reference cards. 

Technical Support 
If you do not find the answers to questions or problems that 
you have, contact Freedom Scientific Technical Support, 
(727) 803-8600 or e-mail Support@FreedomScientific.com. 
Office hours are from Monday through Friday 8:30 A.M. to 
7:00 P.M. Eastern Standard Time. 

Please have the following information on hand: 
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• Product serial number used for registration. 
• Product name and version number. 
• Type of computer hardware you are using. 
• Software version number of Windows. 

About OpenBook 
Select About OpenBook from the Help menu on the 
OpenBook user interface to view the version number of 
OpenBook you are currently running and its serial number. 
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Desktop Keyboard Layout 
Reading 

Number Announcement 
Toggle 

CTRL+SHIFT+N 

Read Dialog Box in Tab 
Order 

INSERT+B 

Say Character NUM PAD 5 

Say Word INSERT+NUM PAD 5 

Spell Word INSERT+NUM PAD 5 twice 
quickly 

Spell Word Phonetically INSERT+NUM PAD 5 three 
times quickly 

Say Line INSERT+UP ARROW 

Say Sentence ALT+NUM PAD 5 

Say Paragraph CTRL+NUM PAD 5 

Say To Cursor INSERT+HOME 

Say From Cursor INSERT+PAGE UP 

Say Top Line of Window INSERT+END 

Read Status Bar INSERT+PAGE DOWN 

Say Window Title INSERT+T 

Say All INSERT+DOWN ARROW 

Skim Read CTRL+INSERT+DOWN 
ARROW 
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Fast Forward/Rewind (during 
Say All or skimming) 

LEFT/RIGHT ARROW or 
LEFT SHIFT/RIGHT SHIFT 

Silence Speech CTRL 

Audio File Navigation 
Start/Stop Audio Playback INSERT+DOWN ARROW 

Pause Playback CTRL 

Move to the Next Heading or 
Audio File 

DOWN ARROW 

Move to the Previous 
Heading or Audio File 

UP ARROW 

Expand a subheading (in 
DAISY files only) 

RIGHT ARROW 

Close a subheading (in 
DAISY files only) 

LEFT ARROW 

Say Current Heading or 
Audio File 

INSERT+NUM PAD 5 

Move to the First Heading or 
Audio File 

CTRL+HOME 

Move to the Last Heading or 
Audio File 

CTRL+END 

Fast Forward Five Seconds RIGHT ARROW or RIGHT 
SHIFT 

Rewind Five Seconds LEFT ARROW OR LEFT 
SHIFT 

Increase Playback Rate for 
DAISY Audio Files 

ALT+CTRL+PAGE UP 
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Decrease Playback rate for 
DAISY Audio Files 

ALT+CTRL+PAGE DOWN 

Document Navigation 
Back Space BACKSPACE 

Go To Bookmark F9 

Open Go To Dialog CTRL+G 

Go To Next item (page, 
bookmark, comment, or 
highlight) as specified in Go 
To dialog 

F5 

Go To Prior item (page, 
bookmark, comment, or 
highlight) as specified in Go 
To dialog 

SHIFT+F5 

Say Next Character (Edit 
Mode) 

RIGHT ARROW (moves by 
word in Read-only mode) 

Say Prior Character (Edit 
Mode) 

LEFT ARROW (moves by 
word in Read-only mode) 

Say Next Word CTRL+RIGHT ARROW, 
INSERT+RIGHT ARROW, or 
RIGHT ARROW when in 
Read-only Mode 

Say Prior Word CTRL+LEFT ARROW, 
INSERT+LEFT ARROW, or 
LEFT ARROW when in Read-
Only Mode 

Say Next Line DOWN ARROW 

Say Prior Line UP ARROW 



12 

Say Next Sentence ALT+DOWN ARROW 

Say Prior Sentence ALT+UP ARROW 

Say Next Paragraph CTRL+DOWN ARROW 

Say Prior Paragraph CTRL+UP ARROW 

Next Page CTRL+PAGE DOWN 

Prior Page CTRL+PAGE UP 

Page Down PAGE DOWN 

Page Up PAGE UP 

End of File CTRL+END 

Top of File CTRL+HOME 

Help 
Context Sensitive Help SHIFT+F1 

Help F1 

Keyboard Help INSERT+1 

Where Am I CTRL+SHIFT+F12 

Text Selection 
Select Next Character (Edit 
Mode) 

SHIFT+RIGHT ARROW 

Select Prior Character (Edit 
Mode) 

SHIFT+LEFT ARROW 

Select Next Word CTRL+SHIFT+RIGHT 
ARROW, 
INSERT+SHIFT+RIGHT 
ARROW, or SHIFT+RIGHT 
ARROW in Read-only Mode 
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Select Prior Word CTRL+SHIFT+LEFT ARROW, 
INSERT+SHIFT+LEFT 
ARROW, or SHIFT+LEFT 
ARROW in Read-only Mode 

Select Next Line SHIFT+DOWN ARROW 

Select Prior Line SHIFT+UP ARROW 

Select to End of Line SHIFT+END 

Select to Beginning of Line SHIFT+HOME 

Select Next Page SHIFT+PAGE DOWN 

Select Prior Page SHIFT+PAGE UP 

Select to Beginning of Page CTRL+SHIFT+HOME 

Select to End of Page CTRL+SHIFT+END 

Select All text on current 
page 

CTRL+A 

Say Selected Text INSERT+SHIFT+DOWN 
ARROW 

Scanning 
Toggle Recognize Columns CTRL+SHIFT+Z 

Scan F4 or SPACEBAR when

Scan Preview CTRL+SHIFT+F3 

Scan and Replace Current 
Page 

CTRL+SHIFT+F4 

BuckScan money identifier CTRL+M 

Scanning Mode List APPLICATIONS Key 
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Visual Settings 
Cycle Between Views CTRL+SHIFT+V 

Font Background Color CTRL+5 

Font Size – Increase CTRL+4 

Font Size – Decrease CTRL+3 

Font Spacing – Increase CTRL+8 

Font Spacing – Decrease CTRL+7 

Font Type CTRL+6 

Scroll Exact View Down ALT+CTRL+DOWN ARROW 

Scroll Exact View Left ALT+CTRL+LEFT ARROW 

Scroll Exact View Right ALT+CTRL+RIGHT ARROW 

Scroll Exact View Up ALT+CTRL+UP ARROW 

Increase Zoom Level CTRL+ALT+4 

Decrease Zoom Level CTRL+ALT+3 

Zoom 25 Percent ALT+SHIFT+1 

Zoom 50 Percent ALT+SHIFT+2 

Zoom 75 Percent ALT+SHIFT+3 

Zoom 100 Percent ALT+SHIFT+4 

Zoom 110 Percent ALT+SHIFT+5 

Zoom 120 Percent ALT+SHIFT+6 

Zoom 130 Percent ALT+SHIFT+7 

Zoom 140 Percent ALT+SHIFT+8 

Zoom 150 Percent ALT+SHIFT+9 
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Zoom 175 Percent ALT+SHIFT+A 

Zoom 200 Percent ALT+SHIFT+B 

Zoom 300 Percent ALT+SHIFT+C 

Zoom 400 Percent ALT+SHIFT+D 

Zoom 500 Percent ALT+SHIFT+E 

Zoom 600 Percent ALT+SHIFT+F 

Zoom 700 Percent ALT+SHIFT+G 

Zoom 800 Percent ALT+SHIFT+H 

OpenBook Feature Hotkeys 

Insert Bookmark CTRL+F9 

Delete Bookmark CTRL+SHIFT+F9 

Insert Comment ALT+CTRL+M 

Delete Comment SHIFT+DELETE 

Edit Comment ALT+ENTER 

Say Comment ALT+SHIFT+ APOSTROPHE 

Begin/end Highlight CTRL+F11 

Highlight Selected Text ALT+F11 

Cancel Highlight ESC 

Remove Highlight CTRL+SHIFT+F11 

Say Highlight ALT+CTRL+F11 

Toggle Highlight 
Announcement 

ALT+SHIFT+F11 

Next  Highlight F11 
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Prior Highlight SHIFT+F11 

Copy to Clipboard CTRL+C 

Cut to Clipboard (Edit mode) CTRL+X 

Paste from Clipboard (Edit 
mode) 

CTRL+V 

Delete Current Page CTRL+DELETE 

Delete Character (Edit Mode) DELETE 

Dictionary CTRL+D or F8 

Edit Mode/Read-only Mode 
toggle 

CTRL+E 

Move Page Down in page 
order 

ALT+PAGE DOWN 

Move Page Up in page order ALT+PAGE UP 

Insert Page Break (Edit 
Mode) 

CTRL+ENTER 

Delete Page Break (Edit 
Mode) 

CTRL+SHIFT+DELETE 

Find text CTRL+F 

Find next occurrence of text CTRL+SHIFT+F 

Replace text (Edit Mode) CTRL+H 

Spell Check F7 

Thesaurus CTRL+T 

Undo CTRL+Z 

Decrease Voice Rate ALT+CTRL+PAGE DOWN 

Increase Voice Rate ALT+CTRL+PAGE UP 
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Mute Synthesizer CTRL+F5 

Close Document Window CTRL+F4 

Document Toggle CTRL+F6 

New File CTRL+N 

Open File CTRL+O 

Print CTRL+P 

Save Current Page CTRL+SHIFT+S 

Save Document CTRL+S 

Exit OpenBook ALT+F4 
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Laptop Keyboard Layout 
Reading 

Number Announcement 
Toggle 

CTRL+SHIFT+N 

Read Dialog Box in Tab 
Order 

INSERT+B 

Say Character CAPSLOCK+COMMA 

Say Word CAPSLOCK+K 

Spell Word CAPSLOCK+K twice quickly 

Spell Word Phonetically CAPSLOCK+K three times 
quickly 

Say Line CAPSLOCK+UP ARROW or 
CAPSLOCK+I 

Say Sentence CAPSLOCK+H 

Say Paragraph CAPSLOCK+CTRL+I 

Say To Cursor CAPSLOCK+SHIFT+J 

Say From Cursor CAPSLOCK+PAGE UP or 
CAPSLOCK+SHIFT+L 

Say Top Line of Window CAPSLOCK+END or 
CAPSLOCK+SHIFT+Y 

Read Status Bar CAPSLOCK+SHIFT+N 

Say Window Title CAPSLOCK+T 

Say All CAPSLOCK+DOWN ARROW 
or CAPSLOCK+A 
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Skim Read CTRL+INSERT+DOWN 
ARROW 

Fast Forward/Rewind (during 
Say All or skimming)  

LEFT/RIGHT ARROW or 
LEFT SHIFT/RIGHT SHIFT 

Silence Speech  CTRL 

Audio File Navigation 
Start/Stop Audio Playback INSERT+DOWN ARROW 

Pause Playback CTRL 

Move to the Next Heading or 
Audio File 

DOWN ARROW 

Move to the Previous 
Heading or Audio File 

UP ARROW 

Expand a subheading (in 
DAISY files only) 

RIGHT ARROW 

Close a subheading (in 
DAISY files only) 

LEFT ARROW 

Say Current Heading or 
Audio File 

CAPSLOCK+K 

Move to the First Heading or 
Audio File 

CTRL+HOME 

Move to the Last Heading or 
Audio File 

CTRL+END 

Fast Forward Five Seconds RIGHT ARROW or RIGHT 
SHIFT 

Rewind Five Seconds LEFT ARROW OR LEFT 
SHIFT 
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Increase Playback Rate for 
DAISY Audio Files 

ALT+CTRL+PAGE UP 

Decrease Playback rate for 
DAISY Audio Files 

ALT+CTRL+PAGE DOWN 

Document Navigation 
Back Space BACKSPACE 

Go To Bookmark F9 

Open Go To Dialog CTRL+G 

Go To Next item (page, 
bookmark, comment, or 
highlight) as specified in Go 
To dialog 

F5 

Go To Prior item (page, 
bookmark, comment, or 
highlight) as specified in Go 
To dialog 

SHIFT+F5 

Say Next Character (Edit 
Mode) 

RIGHT ARROW or 
CAPSLOCK+PERIOD (moves 
by word in Read-only Mode)  

Say Prior Character (Edit 
Mode) 

LEFT ARROW or 
CAPSLOCK+M (moves by 
word in Read-only Mode) 

Say Next Word CTRL+RIGHT ARROW, 
INSERT+RIGHT ARROW, or 
RIGHT ARROW when in 
Read-only Mode 

Say Prior Word CTRL+LEFT ARROW, 

Say Next Line DOWN ARROW or 
CAPSLOCK+O 
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Say Prior Line UP ARROW or 
CAPSLOCK+U 

Say Next Sentence ALT+DOWN ARROW 

Say Prior Sentence ALT+UP ARROW or 
CAPSLOCK+Y 

Say Next Paragraph CTRL+DOWN ARROW 

Say Prior Paragraph CTRL+UP ARROW or 
CAPSLOCK+CTRL+U 

Next Page CTRL+PAGE DOWN 

Prior Page CTRL+PAGE UP 

Page Down PAGE DOWN 

Page Up PAGE UP 

End of File CTRL+END 

Top of File CTRL+HOME 

Help 
Context Sensitive Help SHIFT+F1 

Help F1 

Keyboard Help INSERT+1 or CAPSLOCK+1 

Where Am I CTRL+SHIFT+F12 

Text Selection 
Select Next Character (Edit 
Mode) 

SHIFT+RIGHT ARROW 

Select Prior Character (Edit 
Mode) 

SHIFT+LEFT ARROW 
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Select Next Word CTRL+SHIFT+RIGHT 
ARROW, 
INSERT+SHIFT+RIGHT 
ARROW, or SHIFT+RIGHT 
ARROW in Read-only Mode 

Select Prior Word CTRL+SHIFT+LEFT ARROW, 
INSERT+SHIFT+LEFT 
ARROW, or SHIFT+LEFT 
ARROW in Read-only Mode 

Select Next Line SHIFT+DOWN ARROW 

Select Prior Line SHIFT+UP ARROW 

Select to End of Line SHIFT+END 

Select to Beginning of Line SHIFT+HOME 

Select Next Page SHIFT+PAGE DOWN 

Select Prior Page SHIFT+PAGE UP 

Select to Beginning of Page CTRL+SHIFT+HOME 

Select to End of Page CTRL+SHIFT+END 

Select All text on current 
page 

CTRL+A 

Say Selected Text CAPS LOCK+SHIFT+DOWN 
ARROW or 
CAPSLOCK+SHIFT+A 

Scanning 
Toggle Recognize Columns CTRL+SHIFT+Z 

Scan F4 or SPACEBAR when 

Scan Preview CTRL+SHIFT+F3 
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Scan and Replace Current 
Page 

CTRL+SHIFT+F4 

BuckScan money identifier CTRL+M 

Scanning Mode List APPLICATIONS Key 

Visual Settings 
Cycle Between Views CTRL+SHIFT+V 

Font Background Color CTRL+5 

Font Size – Increase CTRL+4 

Font Size – Decrease CTRL+3 

Font Spacing – Increase CTRL+8 

Font Spacing – Decrease CTRL+7 

Font Type CTRL+6 

Scroll Exact View Down ALT+CTRL+DOWN ARROW 

Scroll Exact View Left ALT+CTRL+LEFT ARROW 

Scroll Exact View Right ALT+CTRL+RIGHT ARROW 

Scroll Exact View Up ALT+CTRL+UP ARROW 

Increase Zoom Level CTRL+ALT+4 

Decrease Zoom Level CTRL+ALT+3 

Zoom 25 Percent ALT+SHIFT+1 

Zoom 50 Percent ALT+SHIFT+2 

Zoom 75 Percent ALT+SHIFT+3 

Zoom 100 Percent ALT+SHIFT+4 

Zoom 110 Percent ALT+SHIFT+5 
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Zoom 120 Percent ALT+SHIFT+6 

Zoom 130 Percent ALT+SHIFT+7 

Zoom 140 Percent ALT+SHIFT+8 

Zoom 150 Percent ALT+SHIFT+9 

Zoom 175 Percent ALT+SHIFT+A 

Zoom 200 Percent ALT+SHIFT+B 

Zoom 300 Percent ALT+SHIFT+C 

Zoom 400 Percent ALT+SHIFT+D 

Zoom 500 Percent ALT+SHIFT+E 

Zoom 600 Percent ALT+SHIFT+F 

Zoom 700 Percent ALT+SHIFT+G 

Zoom 800 Percent ALT+SHIFT+H 

OpenBook Feature Hotkeys 

Insert Bookmark CTRL+F9 

Delete Bookmark CTRL+SHIFT+F9 

Insert Comment ALT+CTRL+M 

Delete Comment SHIFT+DELETE 

Edit Comment ALT+ENTER 

Say Comment ALT+SHIFT+ APOSTROPHE 

Begin/end Highlight CTRL+F11 

Highlight Selected Text ALT+F11 

Cancel Highlight ESC 

Remove Highlight CTRL+SHIFT+F11 
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Say Highlight ALT+CTRL+F11 

Toggle Highlight 
Announcement 

ALT+SHIFT+F11 

Next  Highlight F11 

Prior Highlight SHIFT+F11 

Copy to Clipboard CTRL+C 

Cut to Clipboard (Edit mode) CTRL+X 

Paste from Clipboard (Edit 
mode) 

CTRL+V 

Delete Current Page CTRL+DELETE 

Delete Character (Edit Mode) DELETE 

Dictionary CTRL+D or F8 

Edit Mode/Read-only Mode 
toggle 

CTRL+E 

Move Page Down in page 
order 

ALT+PAGE DOWN 

Move Page Up in page order ALT+PAGE UP 

Insert Page Break (Edit 
Mode) 

CTRL+ENTER 

Delete Page Break (Edit 
Mode) 

CTRL+SHIFT+DELETE 

Find text CTRL+F 

Find next occurrence of text CTRL+SHIFT+F 

Replace text (Edit Mode) CTRL+H 

Spell Check F7 
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Thesaurus CTRL+T 

Undo CTRL+Z 

Decrease Voice Rate ALT+CTRL+PAGE DOWN 

Increase Voice Rate ALT+CTRL+PAGE UP 

Mute Synthesizer CTRL+F5 

Close Document Window CTRL+F4 

Document Toggle CTRL+F6 

New File CTRL+N 

Open File CTRL+O 

Print CTRL+P 

Save Current Page CTRL+SHIFT+S 

Save Document CTRL+S 

Exit OpenBook ALT+F4 
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Traditional (Ruby) Keyboard Layout 
Reading 

Read Dialog Box in Tab 
Order 

CTRL+B 

Read Status Bar CTRL+SHIFT+F10 

Say All F10, F12 or NUM PAD 
ENTER 

Skim Read SHIFT+F12 

Fast Forward/Rewind (during 
Say All or skimming) 

LEFT/RIGHT ARROW or

Silence Speech CTRL 

Audio File Navigation 
Start/Stop Audio Playback F10, F12 or NUM PAD 

ENTER 

Pause Playback CTRL 

Move to the Next Heading or 
Audio File 

DOWN ARROW 

Move to the Previous 
Heading or Audio File 

UP ARROW 

Expand a subheading (in 
DAISY files only) 

RIGHT ARROW 

Close a subheading (in 
DAISY files only) 

LEFT ARROW 

Say Current Heading or 
Audio File 

NUM PAD 5 
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Move to the First Heading or 
Audio File 

CTRL+HOME 

Move to the Last Heading or 
Audio File 

CTRL+END 

Fast Forward Five Seconds RIGHT ARROW or RIGHT 
SHIFT 

Rewind Five Seconds LEFT ARROW OR LEFT 
SHIFT 

Increase Playback Rate for 
DAISY Audio Files 

CTRL+2 or NUM PAD 
ASTERISK 

Decrease Playback rate for 
DAISY Audio Files 

CTRL+1 or SHIFT+NUM 
PAD ASTERISK 

Document Navigation 
Go To Bookmark F9 

Open Go To Dialog CTRL+G 

Go To Next item (page, 
bookmark, comment, or 
highlight) as specified in Go 
To dialog 

F5 

Go To Prior item (page, 
bookmark, comment, or 
highlight) as specified in Go 
To dialog 

SHIFT+F5 

Say Next Character (Edit 
Mode) 

RIGHT ARROW (moves by 
word in Read-only Mode) 

Say Prior Character (Edit 
Mode) 

LEFT ARROW (moves by 
word in Read-only Mode) 
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Say Next Word (Read-only 
Mode) 

RIGHT ARROW 

Say Prior Word (Read-only 
Mode) 

LEFT ARROW 

Say Next Line DOWN ARROW 

Say Prior Line UP ARROW 

Say Next Paragraph CTRL+DOWN ARROW 

Say Prior Paragraph CTRL+UP ARROW 

Next Page CTRL+PAGE DOWN 

Prior Page CTRL+PAGE UP 

Move Up One Screen PAGE UP 

Move Down One Screen PAGE DOWN 

End of File CTRL+END 

Top of File CTRL+HOME 

Help 
Help F1 or NUM PAD MINUS 

Help, context-sensitive help SHIFT+NUM PAD 

Key Describer toggle CTRL+F12 

Where Am I CTRL+SHIFT+F12 or NUM 
PAD 7 

Text Selection 
Select Next character (Edit 
Mode) 

SHIFT+RIGHT ARROW 
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Select Prior character (Edit 
Mode) 

SHIFT+LEFT ARROW 

Select Next Word CTRL+SHIFT+RIGHT 
ARROW or SHIFT+RIGHT 
ARROW in Read-only Mode 

Select Prior Word CTRL+SHIFT+LEFT ARROW 
or SHIFT+LEFT ARROW in 
Read-only Mode 

Select Next Line SHIFT+DOWN ARROW 

Select Prior Line SHIFT+UP ARROW 

Select Next Page SHIFT+PAGE DOWN 

Select Prior Page SHIFT+PAGE UP 

Select to beginning of page CTRL+SHIFT+HOME 

Select to end of page CTRL+SHIFT+END 

Select to beginning of line SHIFT+HOME 

Select to end of line SHIFT+END 

Select All text on current 
page 

CTRL+A 

Scanning 
Toggle Recognize Columns CTRL+SHIFT+Z 

Scan (Edit Mode) F4 or NUM PAD INSERT 

Scan (Read-only Mode) SPACEBAR, F4, or NUM 

Scan Preview CTRL+NUM PAD INSERT 

Scan and Replace Current 
Page 

CTRL+SHIFT+F4 
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BuckScan money identifier CTRL+M 

Scanning Mode List SHIFT+F10 

Visual Settings 
Cycle Between Views CTRL+SHIFT+V 

Font size – increase CTRL+4 

Font size – decrease CTRL+3 

Font / Background Color CTRL+5 

Font type CTRL+6 

Font spacing – increase CTRL+8 

Font spacing – decrease CTRL+7 

Scroll Exact View Down ALT+CTRL+DOWN ARROW 

Scroll Exact View Left ALT+CTRL+LEFT ARROW 

Scroll Exact View Right ALT+CTRL+RIGHT ARROW 

Scroll Exact View Up ALT+CTRL+UP ARROW 

Increase Zoom Level CTRL+ALT+4 

Decrease Zoom Level CTRL+ALT+3 

Zoom 25 Percent ALT+SHIFT+1 

Zoom 50 Percent ALT+SHIFT+2 

Zoom 75 Percent ALT+SHIFT+3 

Zoom 100 Percent ALT+SHIFT+4 

Zoom 110 Percent ALT+SHIFT+5 

Zoom 120 Percent ALT+SHIFT+6 

Zoom 130 Percent ALT+SHIFT+7 
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Zoom 140 Percent ALT+SHIFT+8 

Zoom 150 Percent ALT+SHIFT+9 

Zoom 175 Percent ALT+SHIFT+A 

Zoom 200 Percent ALT+SHIFT+B 

Zoom 300 Percent ALT+SHIFT+C 

Zoom 400 Percent ALT+SHIFT+D 

Zoom 500 Percent ALT+SHIFT+E 

Zoom 600 Percent ALT+SHIFT+F 

Zoom 700 Percent ALT+SHIFT+G 

Zoom 800 Percent ALT+SHIFT+H 

OpenBook Feature Hotkeys 
Copy text CTRL+C 

Cut text (Edit mode) CTRL+X 

Paste text (Edit mode) CTRL+V 

Delete Current Page CTRL+DELETE 

Delete Character (Edit 
Mode) 

DELETE 

Dictionary CTRL+D or F8 

Edit Mode/Read-only Mode 
toggle 

CTRL+E 

Move Page Down in page 
order 

ALT+PAGE DOWN 

Move Page Up in page order ALT+PAGE UP 
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Insert Page Break (Edit 
Mode) 

CTRL+ENTER 

Delete Page Break (Edit 
Mode) 

CTRL+SHIFT+DELETE 

Find text CTRL+F 

Find next occurrence of text CTRL+SHIFT+F 

Replace text (Edit Mode) CTRL+H 

Spell Check F7 or CTRL+K 

Spell Word CTRL+L, F3 twice, or NUM 
PAD 5 twice 

Spell Word Phonetically CTRL+SHIFT+L, F3 three 
times, or NUM PAD 5 three 
times 

Thesaurus CTRL+T or SHIFT+F8 

Undo CTRL+Z 

Insert Bookmark CTRL+F9 

Delete Bookmark CTRL+SHIFT+F9 

Close current document CTRL+F4 or CTRL+W 

Decrease Voice Rate CTRL+1 or SHIFT NUM PAD 
ASTERISK 

Increase Voice Rate CTRL+2 or NUM PAD 
ASTERISK 

Mute Synthesizer CTRL+F5 

Document Properties CTRL+R 

Exit OpenBook ALT+F4 

New File CTRL+N 
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Open File CTRL+O 

Print current document CTRL+P 

Save current document CTRL+S 

Toggle Windows CTRL+F6 

Word Count SHIFT+F7 

Using the NUM PAD on a Portable PC 
You can use OpenBook on a portable notebook or laptop 
computer. However, most portable computers do not have 
standard 17-key keypads. We have therefore assigned 
alternate keys to the OpenBook NUM PAD functions. 

Scan F4 or SPACEBAR 

Delete Page CTRL+DELETE 

Speak F10 or F12 

Select ENTER 

Escape ESC 

Key Describer CTRL+F12 

Where Am I? SHIFT+CTRL+F12 

Help F1 

Voice Rate CTRL+1 and CTRL+2 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move Left LEFT ARROW 

Move Right RIGHT ARROW 

Page Up PAGE UP 
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Page Down PAGE DOWN 

 


